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WORKSHOP  
MICROSOFT OFFICE EXCEL 

SHIPPING, FINANCE AND MANAGEMENT SKILLS 
 
Instructor: Stella Moysiadou, Adjunct Lecturer, Post-Doctoral Researcher, Laboratory for 
International Shipping, Finance and Management, Athens University of Economics and Business 
E-mail: stm@aueb.gr  
 

PART I 

Introduction 
The ability to effectively use Microsoft (Ms) Office software is considered one of the most 
fundamental skills required in office environments. According to the findings of an IDC1 study 
conducted in 2013 in the United States investigating a sample of 14.6 million job listings, Ms 
Office literacy was the second most highly ranked skill by employers for positions expected to 
experience above-average growth and salary potential between the years 2013-2020. In fact, Ms 
Office skills were topped only by oral and written communication skills. 
 
Microsoft Office Excel provides users with the ability to organize, manage and analyze 
quantitative data, which is critical for the right evaluation and effective communication of 
information in business environments. Moreover, Ms Excel proficient users have the potential to 
be more productive at work, performing daily tasks time-efficiently and ensuring high-quality and 
trustworthy output for the upper management. 
 
The aim of this workshop is to familiarize participants with Excel tools and commands that can 
help organize one’s job better, save time, enhance the ability to multi-task and collaborate with 
others efficiently, feeling confident about the output communicated to the management.  
 
The course will be conducted in 12 teaching hours of commands’ demonstration and hands-on 
practice, focusing on relevant with the MSc in ISFM  content and providing a clear understanding 
of every command’s objective and attained outcome.  
 
It must be highlighted at this point that acquiring Excel skills is a continuous process that requires 
personal motivation to experiment, keep up with new features incorporated in latest versions of 
the software and push oneself to adopt new tools available in order to address everyday 
challenges at work. Thus, it is crucial that participants understand that this training course will be 
of benefit only if they actively apply and practice on the knowledge they will acquire through the 
course, with an attitude of making technology an ally for everyday activities at work. 
 

 
1 International Data Corporation (IDC) is the premier global provider of market intelligence, advisory services, and 
events for the information technology, telecommunications, and consumer technology markets. 
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Section I: Exploring and Customizing the Excel workbook to individual needs  
 
Ms Excel stores spreadsheets in files called workbooks. The set of tabs and icons at the top of an 
Excel workbook that allows you to quickly find and use commands for completing tasks is called 
‘the Ribbon’. The Ribbon is made up of four basic components: tabs (e.g. Home, Insert, Design, 
Layout etc.), groups per tab (e.g. in the Home tab, groups available are the Clipboard group, the 
Font/Paragraph/Styles group etc.), dialog launchers (i.e. the arrow-like buttons at the bottom 
right corner of each group), and command buttons (i.e. the buttons you can see on the Ribbon). 
The Excel workbook also includes toolbars such as the Quick Access toolbar (located in the upper 
left corner of the workbook) and the Status Bar (located at the very bottom of the workbook). 
 
 A great feature of Ms Excel is the option to customize the Ribbon and its toolbars to the 
individual needs of the user. For example,  

a) the order that tabs appear on the Ribbon can be changed,  
b) new tabs and groups can be created with commands that the user frequently needs,  
c) buttons on the quick access toolbar can be added to be readily available at one click only 

and, 
d) useful information can be displayed at the status bar while editing the workbook, 

according to the user’s preference. 
Moreover, the Options menu of the File tab offer further potential to customize the workbook. 
 
Through the following steps, the user will learn how to customize/personalize the excel 
workbook and useful commands that can facilitate working with the program. Further 
customization options will be presented during the course where relevant. 
 

1. Create a new blank workbook (File, New, Blank workbook). 

2. Explore the Excel window (worksheets, ribbon, tabs, groups of tools, name box, insert 

function box, formula bar, quick access toolbar, status bar, scroll bars, workbook views 

shortcuts, zoom slider). 

3. Customize the Ribbon: Create a new Tab with tools you frequently use and want easier 

access to, such as a shortcut to the Windows Calculator, the ‘Speak cells’ button, the ‘Zoom 

to Selection’ button, the ‘Zoom to 100%’ button, the ‘Superscript’ and the ‘Subscript’ 

buttons. Organize the tools/buttons into different groups to facilitate yourself finding them 

(File, Options, Customize Ribbon). 

4. Customize the Quick Access Toolbar to include tools you want readily available. For 

example, add the ‘E-mail as PDF attachment’ and the ‘Select Visible Cells’ buttons. Check 

whether you prefer the Quick access toolbar to be placed below the Ribbon or not (File, 

Options, Quick access toolbar) 

5. Find out how you can remove specific customization you made on either the Ribbon or the 

Quick Access toolbar and how to reset default customization.  

6. Create a backup file with the customization you made to the Ribbon and the Quick Access 

toolbar to apply the same customization easily to Ms Excel on another computer you use 

(File, Options, Customize Ribbon/Quick access toolbar, Export all customizations). 
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7. Customize the Status Bar to display information that will be helpful to see while editing 

the workbook: for example, the Cell Mode, Workbook Statistics, the Page number 

(displayed when in Page Layout view), whether Caps Lock or Num Lock is activated, the 

result of the functions Average, Count, Minimum, Maximum and Sum for a selection of 

data you make (right click on Status Bar) 

8. Adjust the size of the formula bar to display more information.  

9. Set the font, font size and view for the new worksheets you create to Times New Roman, 

12 and normal, respectively. Set the number of worksheets to be included in new 

worksheets to two (File, Options, General, When creating new workbooks). 

10. Modify the name of the author that the documents you create will display. Other people 

that you share the documents with can see the author’s name in documents’ properties and 

comments or in changes you make that are being tracked, so there may be cases where you 

would wish to modify this information. You should keep in mind that changes in the 

author’s name are applied to all Ms Office applications (File, Options, General, Personalize 

your copy of Microsoft Office). 

11. The option to change the Office applications’ background and theme is not merely an 

aesthetic feature but can also increase eye-comfort. Background and theme changes affect 

all Ms Office applications. Check out how you can modify these settings (File, Options, 

General, Personalize your copy of Microsoft Office). 

 

Appendix I:  

Microsoft official support pages for the commands used in Section I 

✓ Create a new workbook 
✓ Customize the Ribbon  
✓ Customize the Quick Access Toolbar 
✓ Remove a command from the Quick Access Toolbar  
✓ Reset the Quick Access Toolbar to the default settings  
✓ Export your Ribbon and Quick Access Toolbar customizations into a file  
✓ Excel status bar options  
✓ Office Options - The General tab 
✓ Personalize your copy of Office 
✓ Change the look and feel of Office  

 

 

  

https://support.microsoft.com/en-us/office/create-a-new-workbook-ae99f19b-cecb-4aa0-92c8-7126d6212a83
https://support.microsoft.com/en-us/office/create-a-new-workbook-ae99f19b-cecb-4aa0-92c8-7126d6212a83
file:///C:/Users/user/AppData/Local/Microsoft/Windows/INetCache/Content.Outlook/AWZABMGF/3.%09https:/support.microsoft.com/en-gb/office/customize-the-ribbon-in-office-00f24ca7-6021-48d3-9514-a31a460ecb31
https://support.microsoft.com/en-us/office/customize-the-quick-access-toolbar-43fff1c9-ebc4-4963-bdbd-c2b6b0739e52
https://support.microsoft.com/en-us/office/customize-the-quick-access-toolbar-43fff1c9-ebc4-4963-bdbd-c2b6b0739e52#__toc352651880
https://support.microsoft.com/en-us/office/customize-the-quick-access-toolbar-43fff1c9-ebc4-4963-bdbd-c2b6b0739e52#__toc352651886
https://support.microsoft.com/en-gb/office/customize-the-quick-access-toolbar-43fff1c9-ebc4-4963-bdbd-c2b6b0739e52#__toc352651887
https://support.microsoft.com/en-us/office/excel-status-bar-options-6055ecd9-e20f-4a7a-a611-4481bd488c55
https://support.microsoft.com/en-us/office/office-options-the-general-tab-c51b7db7-d59e-448a-aa8a-7e9310cebae3
https://support.microsoft.com/en-us/office/office-options-the-general-tab-c51b7db7-d59e-448a-aa8a-7e9310cebae3
https://support.microsoft.com/en-us/office/change-the-look-and-feel-of-office-63e65e1c-08d4-4dea-820e-335f54672310
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Section II: Navigating in(between) the worksheet(s) and selecting content 
using the keyboard 
 
Keyboard ‘shortcuts’ are the strategic use of combinations of keys on the keyboard to execute 
commands in the software more time-efficiently. Many users find that using keyboard shortcuts 
for Excel helps them work more quickly. Also, for users with mobility or vision disabilities, 
keyboard shortcuts can be easier than using the touchscreen, and are an essential alternative to 
using a mouse.  
 
Apart from executing commands, working with the keyboard is also more comfortable when 
navigating in large excel spreadsheets. Keyboard shortcuts can be used instead of scrollbars and 
are also convenient for selecting ranges of cells in the document. It must be noted that Excel 
shortcuts refer to the US keyboard layout. Keys for other layouts might not correspond exactly 
to the keys on a US keyboard. 
 
Excel keyboard shortcuts for navigating in the document and selecting content are presented 
below. Additional shortcuts for executing commands of the Ribbon will be presented during the 
course. 
The file that will be used for the purposes of this section is named ‘Fleet’ and contains a list of 
containerships of a company. 
 

A. Activate: 

a. cell G113 (name box/Ctrl+G/ or F5) 

b. cell A1 (Ctrl+Home, unless cell A1 is hidden or frozen) 

c. the last used cell of the worksheet (the intersection of the last used row and column 

of the worksheet) (Ctrl+End) 

d. the first non-blank cell in a continuous range in the same row as the active cell 

(Ctr+← or hover over the left border of the cell and double click) 

e. the first non-blank cell in a continuous range in the same column as the active cell 

(Ctr+↑ or hover over the upper border of the cell and double click) 

f. the last non-blank cell in a continuous range in the same row as the active cell 

(Ctr+→ or hover over the right border of the cell and double click) 

g. the last non-blank cell in a continuous range in the same column as the active cell 

(Ctr+↓ or or hover over the bottom border of the cell and double click) 

B. Navigate: 

a. one row down (Enter) 

b. one row up (Shift+Enter) 

c. one column to the right (Tab) 

d. one column to the left (Shift+Tab) 

e. one screen up (Page up) 

f. one screen down (Page down) 

g. one screen left (Alt+Page Up) 
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h. one screen right (Alt+Page Down) 

i. to the next sheet of the workbook (Ctrl+Page down) 

j. to the previous sheet of the workbook (Ctrl+Page up) 

k. (scroll) to the first/last sheet of the workbook (Ctrl + scrolling buttons for 

worksheets) 

C. Select: 

a. any two adjacent (ranges of) cells (Shift+left mouse-button click/keyboard arrows) 

b. any two non-adjacent (ranges of) cells (Ctrl+ left mouse-button click or Shift+F8, 

left mouse-button click) 

c. a current region of data (Ctrl+A or Ctrl+Shift+Spacebar once) 

d. all cells in the worksheet (Ctrl+A or Ctrl+Shift+Spacebar twice if necessary or click 

the select all button) 

e. a whole column (Ctrl+Space Bar) 

f. a whole row (Shift+Space Bar) 

g. a current and next worksheet (Ctrl+Shift+Page Down) 

h. a current and previous worksheet (Ctrl+Shift+Page Up) 

i. all objects on a worksheet when one object is already selected 

(Ctrl+Shift+Spacebar) 

j. all cells in the worksheet that include formulas (Ctrl+G or F5, Special, Formulas) 

k. all blank cells in the worksheet (Ctrl+G or F5, Special, Blanks) 

D. Extend a selection of cells to: 

a. any cell you click/navigate using the keyboard in the current worksheet (F8, 

click/type, F8/Esc) 

b. the beginning corner of a data range (Ctrl+Shift+Home) 

c. the ending corner of a data range (Ctrl+Shift+End) 

d. the first non-blank cell/s in a continuous range in the same row/s as the current 

selection (Ctr+Shift+←) 

e. the first non-blank cell/s in a continuous range in the same column/s as the current 

selection (Ctr+Shift+↑) 

f. the last non-blank cell/s in a continuous range in the same row/s as the current 

selection (Ctr+Shift+→) 

g. the last non-blank cell/s in a continuous range in the same column/s as the current 

selection (Ctr+Shift+↓) 

Appendix II:  

Microsoft official support pages for the commands used in Section II 

✓ Keyboard shortcuts for making selections and performing actions 
✓ 50 time-saving Excel shortcuts 
✓ Keyboard shortcuts in Excel 

https://support.microsoft.com/en-us/office/keyboard-shortcuts-in-excel-1798d9d5-842a-42b8-9c99-9b7213f0040f#bkmk_selectwin
https://templates.office.com/en-US/50-time-saving-Excel-shortcuts-TM67670278
https://support.microsoft.com/en-us/office/keyboard-shortcuts-in-excel-1798d9d5-842a-42b8-9c99-9b7213f0040f#bkmk_freqwin


©Stella Moysiadou stm@aueb.gr Page 6 of 10 

Section III: Workbook and Worksheet management, Sorting, Filtering and 
Editing content, Formatting cells 
 
Microsoft Excel is a productivity application – it offers a plethora of tools that enable users work 
more easily and time-efficiently. However, if Excel is used incorrectly, productivity in the 
workplace may even decrease. 
 
Structuring data properly in an excel workbook/worksheet is a cornerstone for work productivity. 
There are wonderful tools for processing information using Excel (e.g. tools for sorting, filtering, 
searching, calculating etc. data) which can however turn useless if the spreadsheet is not 
structured correctly. 
 
Typical mistakes that can deprive the user of the software’s capabilities may include the 
following:  

• Merged cells: while merging cells can make the spreadsheet more aesthetically pleasing, 
it can considerably compromise the software’s ability to read the data or perform 
functions like sorting and filtering. 

• More than one piece of information in a cell: including more than one piece of 
information in a cell makes information processing troublesome. For example, if both first 
and last names of a group of employees are inserted in the same cell with first names 
typed first (e.g. Nick Papadopoulos), then Excel will not be able to sort the list 
alphabetically by the last names. 

• Both numbers and text in a cell: if both text and numbers are included in the same cell, 
then Excel is not able to perform calculations. For example, typing ‘2 apples’ in a cell and 
‘2 oranges’ in another will prohibit Excel from summing the entries (with the difference 

in the types of fruit not being to blame       ) 

• Wrong formatting of cells: cells can be formatted according to their content, as numbers, 
text, dates, currencies etc. If a cell that contains numbers is formatted as text, then Excel 
recognizes the cell content as text and cannot perform calculations that refer to it. 

• Different formatting for the same type of data: Calculations can be messed up if the user 
does not apply cell formatting uniformly per type of data in a worksheet. For example, if 
dates are formatted as both ‘mm/dd/yy’ (‘mm’ standing for two digits indicating the 
month, ‘dd’ the day and ‘yy’ the year – e.g. 08/25/20) and ‘dd/mm/yy’, then calculating 
the difference between the dates will produce faulty results. Similarly, if the thousand 
and decimal separators are not used consistently in a spreadsheet, this will also lead to 
mistakes in calculations. 

• Not quantifying qualitative data: qualitative data can also be processed very easily if 
quantified. It is a common malpractice to highlight content with colors as a means of 
providing/grouping information. For instance, highlighting in a fleet record of 100 vessels 
the ones that are idle does not facilitate the user in counting how many vessels are idle 
or in employment. Instead, if a separate column provides this information via a binary 
variable that takes the value 1 in case the vessel is employed and 0 otherwise, the user 
can much more easily quantify the information, sort it, perform calculations, etc.  
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Exercises in this section focus on commands that facilitate structuring the spreadsheet and 
enhance readability and editability of the content. Moreover, the sorting and filtering tools are 
presented as well as additional keyboard shortcuts and alternative ways to navigate in and 
between the worksheets. 
 
The workbook ‘Crew-Port-Covid-19’ contains updates on restrictions in ports all over the world 
related with crew management during the Covid-19 pandemic. 
 
1. Open the file through the keyboard shortcut (Ctrl+O) 

2. Display a list of all visible worksheets in the workbook and activate one of them (right click 

on the scroll button and double click on the sheet) 

3. Check for any hidden worksheets, unhide and activate them (right click on a sheet, unhide, 

double click on a sheet from the list) 

4. Create a copy of a worksheet using the keyboard (Ctrl+click and drag) 

5. Delete the copy (Right click, Delete OR Home, Cells, Delete, Delete Sheet) 

6. Observe the workbook (workbook statistics: Review, Proofing OR Crtl+Shift+G):  

a. How many worksheets are included? 

b. How may columns and rows does the first worksheet include? 

7. Structure the first worksheet to enhance readability and handiness: 

a. Unhide any rows/columns (select all cells, right click, click Unhide) 

b. Wrap text into multiple lines for all cells of the worksheet and apply center and middle 

alignment (Home Ribbon, Alignment group). 

c. Adjust the columns’ and rows’ height and width to fit the contents (Home tab, Cells group, 

Format, Cell size OR right-click the selected row/column OR drag the boundary with the 

mouse). 

d. Automatically adjust cells to fit the contents (AutoFit Row Height, AutoFit Column 

Width). 

e. Set the ruler units to centimeters (File, Options, Advanced, Display, Ruler Units) 

▪ Check how you can display the ruler (Page Layout view). 

f. From the Page Layout view, set the columns’ width to exactly 8cm and autofit rows’ height 

(View Ribbon, Page Layout OR button on status bar). 

8. Find and select blank cells in the worksheet. Delete any blank columns/rows (Ctrl+G, Special, 

Blanks). Undo the deletion. 

9. Create a copy of the worksheet and move it to a new workbook (Right-click on worksheet tab, 

Move or Copy OR Home Ribbon, Cells group, Format, Organize Sheets, Move or Copy). 

10. Continue working on the initial file. Delete the content of the columns that include 

reviews/changes for specific dates (as indicated by the column titles). Keep cells’ formatting 

(Delete key OR Home Ribbon, Editing group, Clear, Clear contents). 

11. Format columns ‘Last Updated’ and ‘Expected Lockdown lift/next review’ as dates (Home 

Ribbon, Number group, Date OR Right click, Format cells). 
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12. Sort the total range of cells by the column ‘Last Updated’, from most recent to Oldest dates 

(Home Ribbon, Editing Group, Sort & Filter OR Data Ribbon, Sort & Filter group) 

13. Sort the total range of cells first by the column ‘Last Updated’ and then by the column 

‘Country’, to get in alphabetic order the countries with the most recent updates (Custom Sort). 

14. Use the Conditional Formatting tool to highlight cells in the column ‘Restrictions’ that contain 

the word ‘lockdown’. Do the same for the word ‘curfew’ but highlight the respective cells in a 

different colour (Home, Styles, Conditional Formatting, Highlight cell rules, Text that 

contains…) 

15. Sort the total range of cells by: a) the Font colours of cells in column ‘Restrictions’, b) the 

values in column ‘Last Updated’ (from newest to oldest) and c) the values in column ‘Country 

name’ (A to Z).  

16. Cross-check the conditional formatting tool’s accuracy by using text-filters for the words 

‘lockdown’ and ‘curfew’ in column ‘Restrictions’ (Text Filters, Custom Filter). What about 

cells that include both words? 

17. Remove the text filters and clear the conditional formatting rules from the entire worksheet. 

Sort the content by country name from A to Z (Ctrl+Shift+L to turn on filtering for active range 

of cells). 

18. Sort the rest of the worksheets from A to Z. Rename the worksheet ‘Summary’ to keep it as 

the first worksheet in the Workbook. (To Rename worksheets: right click on the sheet tab, To 

Sort worksheets: Alt+F11, Insert, Module, Paste Visual Basic Macro code, File, Close, Alt+F8, 

Run). 

19. Insert hyperlinks in the cells of column ‘Country’ to navigate easily to each country’s 

worksheet (Insert Ribbon, Link, Place in this document). 

20. Save the workbook in a file format that Stores VBA macro code and is compatible with Excel 

2010 and Excel 2007 (.xlsm). Open the saved file and look for the macro.  

21. Save the workbook in a file format that cannot store VBA macro code and is compatible with 

Excel 2010 and Excel 2007 (.xlsx). Open the saved file and look for the macro.  

22. Save only the active sheet as a tab-delimited text file for use on another Microsoft Windows 

operating system (.txt). Import the saved data to Excel. 

Appendix III:  

A. Microsoft official support pages for the commands used in Part II I 

✓ Open files from the file menu 

✓  Workbook statistics 

✓ Hide or show rows or columns 

✓ Wrap text in a cell 

✓ Change the column width and row height 

✓ Use measurement rulers on a worksheet 

✓ Move or copy worksheets or worksheet data 

✓ Clear cells of contents or formats 

https://support.microsoft.com/en-us/office/open-files-from-the-file-menu-97f087d8-3136-4485-8e86-c5b12a8c4176#ID0EAADAAA=Windows
https://support.microsoft.com/en-us/office/check-workbook-statistics-afa12d4b-9584-4826-99a8-33228467e006
https://support.microsoft.com/en-us/office/hide-or-show-rows-or-columns-659c2cad-802e-44ee-a614-dde8443579f8
https://support.microsoft.com/en-us/office/wrap-text-in-a-cell-2a18cff5-ccc1-4bce-95e4-f0d4f3ff4e84
https://support.microsoft.com/en-us/office/change-the-column-width-and-row-height-72f5e3cc-994d-43e8-ae58-9774a0905f46
https://support.microsoft.com/en-us/office/use-measurement-rulers-on-a-worksheet-50cc68ad-64f1-4607-b0e8-d16014609670
https://support.microsoft.com/en-gb/office/move-or-copy-worksheets-or-worksheet-data-47207967-bbb2-4e95-9b5c-3c174aa69328#ID0EAACAAA=Windows
https://support.microsoft.com/en-us/office/clear-cells-of-contents-or-formats-9ff6b8ff-1afd-495f-8ad8-8c1f6f82a9d6
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✓ Format a date the way you want 

✓ Sort data in an Excel worksheet 

✓ Sort data in a range or table 

✓ Use conditional formatting to highlight information 

✓ Filter data in a range or table 

✓ Work with hyperlinks in Excel 

✓ File formats that are supported in Excel 

 

B. Visual Basic code for a macro that sorts worksheets in 

ascending/descending order  

 

Sub Sort_Active_Book() 
Dim i As Integer 
Dim j As Integer 
Dim iAnswer As VbMsgBoxResult 
' 
' Prompt the user as which direction they wish to 
' sort the worksheets. 
' 
   iAnswer = MsgBox("Sort Sheets in Ascending Order?" & Chr(10) _ 
     & "Clicking No will sort in Descending Order", _ 
     vbYesNoCancel + vbQuestion + vbDefaultButton1, "Sort Worksheets") 
   For i = 1 To Sheets.Count 
      For j = 1 To Sheets.Count - 1 
' 
' If the answer is Yes, then sort in ascending order. 
' 
         If iAnswer = vbYes Then 
            If UCase$(Sheets(j).Name) > UCase$(Sheets(j + 1).Name) Then 
               Sheets(j).Move After:=Sheets(j + 1) 
            End If 
' 
' If the answer is No, then sort in descending order. 
' 
         ElseIf iAnswer = vbNo Then 
            If UCase$(Sheets(j).Name) < UCase$(Sheets(j + 1).Name) Then 
               Sheets(j).Move After:=Sheets(j + 1) 
            End If 
         End If 
      Next j 
   Next i 
End Sub 

https://support.microsoft.com/en-us/office/format-a-date-the-way-you-want-8e10019e-d5d8-47a1-ba95-db95123d273e#ID0EAACAAA=Windows
https://support.microsoft.com/en-us/office/quick-start-sort-data-in-an-excel-worksheet-60153f94-d782-47e2-96a8-15cbb7712539
https://support.microsoft.com/en-us/office/sort-data-in-a-range-or-table-62d0b95d-2a90-4610-a6ae-2e545c4a4654
https://support.microsoft.com/en-us/office/use-conditional-formatting-to-highlight-information-fed60dfa-1d3f-4e13-9ecb-f1951ff89d7f
https://support.microsoft.com/en-us/office/filter-data-in-a-range-or-table-01832226-31b5-4568-8806-38c37dcc180e
https://support.microsoft.com/en-us/office/work-with-hyperlinks-in-excel-7fc80d8d-68f9-482f-ab01-584c44d72b3e
https://support.microsoft.com/en-us/office/file-formats-that-are-supported-in-excel-0943ff2c-6014-4e8d-aaea-b83d51d46247
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C. Further Practice 

1. Open the file ‘Fleet Charter List sample’.  
2. Identify pitfalls in the structure of the document. Which Excel tools cannot be used 

due to the workbook’s structure limitations? 
3. Restructure the workbook so that it provides the maximum potential for data 

sorting, filtering, editing and calculations.  


